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Copyright 
© Wellbeing Software 2019  

Registered Office: 3rd Floor i2 Mansfield, Hamilton Court, Oakham Business Park, Mansfield, NG18 5FB 

These materials are or comprise restricted and proprietary confidential information of Wellbeing Software.  

Disclosure to or use by the recipient shall not convey any intellectual property rights in these materials. The right to 

use these materials by the recipient is subject to restrictions and limitations contained in the Provision of Integrated 

Care Record System and Associated Services Agreement and related agreements. 

 

Confidentiality 
All information in this document is provided in confidence for the sole purpose of adjudication of the document and 

shall not be used for any other purpose and shall not be published or disclosed wholly or in part to any other party 

without HSS prior permission in writing and shall be held in safe custody. These obligations shall not apply to 

information which is published or becomes known legitimately from some source other than Wellbeing Software. 

Many of the product, service and company names referred to in this document are trademarks or registered 

trademarks. They are all hereby acknowledged. 
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Introduction 
Purpose 

This document is designed to be utilised by all users of the EuroKing Maternity Information System and covers key 

functionality relating to the CORE application for midwives, other clinical staff involved in maternity services, 

maternity support workers and clerical support staff. 

 

Audience 

This document is intended to be used as a reference guide by all users of the EuroKing Maternity Information System. 
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1. System Overview 
WHAT IS THE EUROKING MATERNITY INFORMATION SYSTEM? 

 

The EuroKing Maternity Information System is an electronic information system used to collect and store specific 

details of a woman’s pregnancy, labour, delivery and postnatal period. The data entered can be used to support 

audit, clinical governance, clinical negligence scheme for Trusts (CNST), Payment by Results (PbR), Maternity Services 

Data Set (MSDS) and research & development. The system facilitates communication between professionals and aids 

in the provision of timely and accurate information for the professionals involved in a woman’s care. In a hospital 

setting it can interface with hospital information systems (HIS) and is compliant with the UK NHS Personal 

Demographics Service (PDS) to register a birth.  

 

KEY BENEFITS OF USING EUROKING 

 

▪ Reducing paper moving towards a paper-lite solution. 

▪ Ability to collect payment by results and compliance with the Maternity services dataset (MSDS). 

▪ Registering the birth and obtaining an NHS number for babies born. 

▪ Offline working in the community negating the need for an internet connection. 

▪ Collection of maternity services audit data/ statistics. 

 

 USER ROLES IN EUROKING 

 
EuroKing is designed to be used by different types of care professionals throughout the course of a pregnancy from 

booking to postnatal discharge. These are: 

 

▪ Midwives & Maternity 

Support Workers 

Workflows for several different care pathways including antenatal, delivery and 

postnatal care with a place to record all aspects of a pregnancy and any past 

medical history. 

▪ Anaesthetists 

Includes workflows to record preassessment, anaesthetic procedures and follow-

ups, the recording of adverse incidents and any relevant documentation. All 

information can be cross referenced against other data held in the system to 

collate NOAD statistics. (National Obstetric Anaesthetic Database). 

▪ Obstetricians 
The Doctors Procedures care pathway provides the ability to record Obstetric 

procedures. 

▪ Support Staff & 

Healthcare Managers 

EuroKing can provide detailed statistical reports for both local and national review 

and planning of maternity services using the Stats and Lists and Stats Builder parts 

of the application. (There are separate support documents for EuroKing Stats and 

Lists and Stats Builder applications.) 
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2. Login and Screen Tour 
LAUNCHING THE APPLICATION 
 

The Euroking Application can be launched via the START MENU or DESKTOP shortcut as applicable: 
 
 
 
 

 
 
 
 
 

Original Euroking E3 Application Icon Next Generation Euroking Application icon 
  

 LOGGING IN TO THE APPLICATION 
 

Enter your EuroKing username (not case-sensitive) and password (case-sensitive). 
 

 
 

 
 
 
 
 
 
 
 
 

LOGIN DETAILS 
 

Username and login details are at bottom left hand side of the screen as follows: 
 

 
 
 
 
 
 
 

 

LOGGING OUT 
 

To LOG OUT click the File Menu and select Logout from the list of options. This closes all active records and returns 
you to the login screen. Alternatively, you can also click Logout via the Home Menu screen. 
 
To EXIT the system, close all open records then click the File Menu and select Exit or simply click the Windows [X] at 
the top right-hand corner of the screen. This shuts down the system and returns the user to the desktop. 
 
It should be noted that exiting the system leaves any open maternity records locked for the next 60 minutes. 
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3. The Home Menu Screen 
 
The EuroKing Home Menu screen displays the following information: 

 

▪ File menus listed across the top to access system functionality. 

▪ Selectable I want to: hyperlink / menu items as follows: 

 
Search for a patient  - Patient Search Function 

Go to CTG monitoring  - Legacy functionality which is no longer applicable 

Read my messages  - Simple Message Function 

Go to the archive  - Legacy functionality which is only applicable to customers using this function already 

Read the training manual - Link to integrated Euroking Helpfiles – Coming Soon 

Logout   - Log out of the Euroking System 

   

▪ Login details shown at the bottom left-hand side of the screen. 

 

 
 

It should be noted that Menu Items and screen options are subject to security access and permissions and are some 

items may be greyed out (i.e. inaccessible) based on security settings. 
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4. Opening a Pregnancy Record 
 

SEARCH FOR A PATIENT 

 
Click Search for a patient from the home menu options list which presents the patient search screen with the 

following search criteria options.  

 

Enter any combination of data and press the [Enter] key or click the search icon on top left-hand side of the search 

box. 

 

 
 

▪ Hospital number searching is recommended. 

▪ NHS number is also recommended and automatically formatted upon entry. 

▪ Forename(s) and surname can be inputted as partial entries and are not case sensitive. 

▪ Date of Birth should be entered using DD/MM/YYYY format. However, data entered is automatically 

formatted and will add backslash characters as you type. 

▪ Age can be entered in years to display all patients of that age and can include a + plus or - minus variable to 

extend the search. 

 
This example will return all patients between the ages of 28 and 31 (i.e. 30 - 2 and 25 + 1). 
 

▪ Delivery Date refers to the date of a live birth and returns all live births for a given date. 
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 SELECTING AND OPENING A RECORD 

 
The search displays a list of all possible matches derived from the search criteria.  
 
- To select a record, double-click an entry. 
 

 
  
If this is the only pregnancy EuroKing will open the pregnancy record directly.  
 
If there are past pregnancies, these will be displayed in a pregnancy list in chronological order below the search list. 
Any closed pregnancy records will be marked as Closed and current pregnancy records will be marked as Open. 
 
- Double-click an entry from the pregnancy to list to open the required pregnancy record. 
 

ADDING A NEW PREGNANCY RECORD 

 

A new pregnancy record will need to be created if all the records are closed or if there are no open pregnancy records 

shown.  

- To add a new pregnancy, click on the Add a pregnancy icon as shown. 
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You will be prompted to confirm that a new pregnancy file is required.  

 

 

 

 

 

 

 

 

- Clicking [Yes] will create a new pregnancy file and opens the record at the Index page ready for completion. 

 

5. Navigating the Pregnancy Record 
 
It should be noted that a pregnancy record contains details of a specific / single pregnancy episode not the woman’s 
full maternity history. The pregnancy record is split into several segments as follows: 
 

 PATIENT BANNER 

 
The patient banner displays: 
 

 
 

▪ Surname, Forename(s) 

▪ Hospital number 

▪ NHS number  

▪ Alerts (Red if there are alerts which has an imbedded hyperlink to the display the specific alerts) 

▪ Gestation 

▪ Born 

▪ Age 

▪ Past obstetric history (gravida and parity). 

 
The banner normally displays with a white background.  An orange background indicates a record without an NHS 
number, a red background indicates the patient is deceased. 
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The banner is an expandable component which opens to reveal additional demographic details and any existing risks. 
A double chevron in this section will open and close this section but this can be accomplished by clicking anywhere 
on the expandable section. To close click back on the chevron or double-click anywhere on the expandable section. 
 
To navigate back to the search or home page select the tabs displayed above the patient name. The page being 

displayed is indicated by the highlighted tab. 

 

 

 

 

 

 

 

 

 

 

CARE PATHWAYS 

 
As the pregnancy record is opened the screen is divided into two sections. On the left-hand side you will see the Care 
Pathways. 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Care pathways are indicated by a folder tree in the left-hand panel. Each parent folder contains the sets of 
questionnaires used for data entry into the maternity record.  
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 MANAGEMENT REPORT 
 

The index page of the pregnancy record is displayed on the right-hand of the screen as you open the pregnancy 

record which contains the Management Report for the pregnancy record. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Management Report contains some key information about the patient demographics (e.g. delivery date, height 

and weight of the patient). It also has a section that allows access to any Patient Episode summaries as well as any 

Risks or Alerts recorded for the pregnancy.  

FORMS 

 

 
The icons along the top of the screen display different forms when selected (e.g. Next of Kin and Pregnancy Screening 

details) and have tool tips / hover help as an operational aid. The highlighted tabs at the bottom can also be used to 

navigate through the forms.  

RISK AND ALERTS 

 

The index page presents a Risks and Alerts section which displays:  

▪ Medical and social risks. 

▪ Alerts. 

▪ Any links to issued guidelines. 
 

If a risks or alerts exist, the menu item is displayed in red and the information about those risks or alerts can be 

accessed from here. 
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TIMELINE 

 

 
 

As data is entered into the pregnancy record a timeline is automatically created at the bottom of the screen and 

shows a visual display of events as the pregnancy progresses.  Entries can be viewed by double-clicking on the icon.  

The timeline also displays links to data from third party applications such as Ultrasound systems if such an interface 

exists. 

CLOSING / EXITING CAREPATHS, INFORMATION FORMS AND PATIENT RECORDS 

 

Whilst using the Euroking system it should be noted that “Carepath Questionnaires” (CPQ’s) and “Information Forms” 

(IF’s) can be closed using the grey [x] located at the top right-hand corner of each section. All CPQ and IF screens will 

remain loaded until they are closed individually, or the patient record itself is closed. 

 

To CLOSE A PATIENT RECORD and therefore all associated CPQ’s and IF’s you should click the red [x] cross which will 

close / exit an entire patient record. 

 

 
 

It is good practice to close patient records once any required workflow entries are completed, as the record will 

remain locked and therefore inaccessible to other users as long as it remains open (i.e. locked) to a user. 

 

6. Data Forms and Data Entry 
 

 ICONS 

 

 
 
The navigation icons at the top of the screen have the following functions: 
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Icon Description Purpose 

 Demographics 

Patient details, contact details, and address. It should be noted that in most 

instances this information is directly populated from the PAS (Patient Information 

Systems) or HIS (Hospital Information System) and can only be entered or edited in 

PAS / HIS not via EuroKing. 

 General Details Details such as marital status, religion, occupation etc. 

 Next of Kin Next of kin details populated from PAS / HIS system 

 Partner Details 

Demographic details of the patient’s partner. It should be noted that if the ‘Father 

of the Baby’ box is ticked this will auto populate this information into the “Father 

Details” form. If next of kin is also the partner of the patient the [Copy NOK Name] 

option button will complete this form from NOK details. 

 Father Details 

Demographic details of the father of the baby can be manually completed, or if the 

if ‘Father of Baby’ box is ticked in the “Partner Details” form the information will be 

automatically populated. 

 Pregnancy Overview 

This is an overview of the pregnancy and labour and is completed as the pregnancy 

progresses. Some answers are populated as the questionnaires are completed e.g. 

LMP & EDD by Scan can be populated from the Current Pregnancy Questionnaire, 

Ante Natal Care received from the Pre-Delivery Questionnaire. 

 Pregnancy Screening 
This is populated by the Booking screening results questionnaire, although there 

are some fields where the data has to be manually entered. 

 Care Professionals 

This identifies the individuals involved in the patient’s care. This form can be 

manually completed but it is also loaded within the Current Pregnancy 

questionnaire. The GP Details are completed automatically with information 

derived from the PAS / HIS system. 

 Babies 

Once a registerable birth is recorded against the Current Pregnancy in EuroKing this 

will show details of the baby/babies such as Birth Order, Date of Birth. EuroKing will 

create a neonatal record for each baby in EuroKing. 

 Pregnancy notes This will display any existing pregnancy notes and allows the addition of new notes. 

 CTG monitoring 
If the EuroKing Application is interfaced with a CTG (Cardiotocography) monitoring 

System this icon will allow access to that information. 

 Close a pregnancy 

Allows users to close a pregnancy on the system and record date and reason for 

example in the event of a patient moving out of the area or in the event of a 

miscarriage. 

 Add Alerts Users are given a choice of alerts from a drop-down menu and to record details. 

 Add Risks 
Users are given a choice of risks to add to the record from a drop-down menu and 

to record details. 

 Patient Notes To view any existing patient notes or to add a note 

 Save 
Any entries or changes made to any of the forms here should be saved before 

closing. 
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Selecting an icon opens a data entry form.  When you have finished with a form it is good working practice to close 

it down by clicking the grey cross at the top right of the icon list. 

 

 

 

These forms are completed from varying sources, some data will come from the hospital Information system, some 

from data entry in other parts of the Euroking system or by manual entry during contact with a patient. The process 

of data entry is common across all forms, so the following examples will illustrate the various methods of data entry. 

FATHER DETAILS FORM 

 

- Select and open a patient. 

 

- Select the father details icon.  

 

This will open the Father Details form which should be completed as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

It is also possible to auto populate address details by clicking the [Copy Mother Address] button if applicable. 

 

- To save the form click the save icon  
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PREGNANCY OVERVIEW 

 

This is an overview of the pregnancy and labour so is completed as the pregnancy progresses. Some answers are 

populated as the Care Pathway questionnaires are completed, for example LMP and EDD by scan are populated by 

the Current Pregnancy questionnaire.  

 

SCREENING RESULTS  

For recording details of all screening tests completed as the pregnancy progresses, this form is largely populated by 

the Booking Results Care Pathway questionnaire however the “Date of Diagnostic Test and Results” should be 

completed manually.  
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CARE PROFESSIONALS FORM DATA ENTRY 
 

- Select the Care Professionals        icon. 
 

This will open the Care Professionals form which should be completed as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Select Lead Clinician from the drop-down list. 

- Select Midwife and Obstetrician using the horizontal ellipsis icons. 

- To save the form click the save  icon.  

 
Please note: Staff lists are populated from the EuroKing system Staff Masterfile, and the GP details should be auto populated via the hospital 
information system (PAS / HIS) 

 

PREGNANCY NOTES AND PATIENT NOTES 

 

PREGNANCY NOTES 

 

This icon       allows access to a window to record a note on the pregnancy record and once there are notes in the 

record the icon turns red.  

 

PATIENT NOTES 

 

This icon       allows access to a window to add a patient note. Any patient notes remain in the woman’s file so once 

entered it will always be available in subsequent pregnancies.    The        red line under the icon indicates that note(s) 

have been added. 
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 ADDING / DELETING ALERTS FORM DATA ENTRY 

 

ADDING ALERTS 

 

- Select the Add Alert          icon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Please note: The list of alerts available in the system is configured at a local level so can be customised to suit the hospital site. 

 

- Select the relevant alert(s) that you wish to add to the pregnancy record. 

 

- Type any additional text in the ‘Detail’ box. 

 

- Select [Add]. 

 

- To save an entry and close the Add Alerts window select [Quit]. 

 

The alert will now be displayed via the index page from the bottom tab and is shown in red in the Risks and Alerts 

box. The details can be expanded by clicking the + button. 
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DELETING ALERTS 

 

- Select the Add Alert          icon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- From the list in the Patient Alerts field select the alert(s) you wish to delete then click on the [Delete] button. 

 

- This will be followed by a confirmation window. 

 

Please note: Deleting removes the alert(s) from this patient’s record, but all alerts will still be available to select for other patients. 

 

  



 

© Wellbeing Software 2019                          All Rights Reserved  Commercial in Confidence 
Effective Date – ESM 16/12/2019   
Wellbeing Doc ref:  EK_CRIB_CM_700_EuroKing_MIS_End_User_Documentation_WS_V1.1.docx   Page 13 of 41 

  

7. Past Obstetric History 
Past Obstetric History is completed via the Gravida link on the main patient banner as it is part of the patient’s clinical 

record and not specific to this pregnancy. For patients without a completed ‘Past Obstetric History’ the word Gravida 

is followed by a question mark. 

- Click on the Gravida: ? link in the patient banner to display the Gravida function. 

 

 

 

 

 

 

 

 

 

- Enter the appropriate numeric Gravida value and click [Continue]. 

 

- Double-click the Gravida link to display the ‘Past Obstetric History’ box. 

 

 

 

 

 

 

 

 

 

 

Please note: An entry of Gravida 2 will present 1 past entry (Past Pregnancy 1) to complete which represents the past pregnancy. The current 
pregnancy is not included in this list. If a number greater than 2 is entered there will be more entries to complete. 

 

- To enter details of a past pregnancy, double-click the “1. Past Pregnancy” entry to display the questionnaire. 

 

-  Complete each question and double-click the response to move to the next question, or alternatively press [Page 

Down] on the keyboard. 

 

Please note: If a partial date is entered and the partial date checkbox selected this will present a mandatory text field requiring to enable you 
to enter a reason. A response of Yes to any question may open additional reciprocal, context-specific questions, in context to the answer 
provided. 
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- Complete all questions and click the Save       icon. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You can make a pregnancy confidential by clicking on the confidential pregnancy  icon. A lock will appear alongside 

the pregnancy and only staff with the correct security access will be able to view the details of that pregnancy. A 

pregnancy can be unlocked using the unlock  icon. 

 

 
 
 

- Once all details are completed, the screen returns to Past Obstetric History and a [Workflow Completed] 

message will appear.  
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You should now complete the ‘Past Baby’ questionnaire: 
 

- Double-click the “1. Past Baby” entry to display the questionnaire. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

- Complete each question and double-click the response to move to the next question, or alternatively press [Page 

Down] on the keyboard. 

 

- Complete all questions and click the Save       icon. 

 

- Once all details are completed, the screen returns to Past Obstetric History and a [Workflow Completed] 

message will appear as before. 

 
The Gravida and Parity are now displayed on the Patient Banner and can be selected again to be referenced or 

updated. This Past Obstetric History is linked to the patient rather than the pregnancy record and will automatically 

be included as part of her notes in any future pregnancies recorded on the EuroKing system. 
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8. Care Pathways - Antenatal  
 PURPOSE AND USE OF CARE PATHWAYS 

 
Maternity record questionnaires or Care Pathways are used to enter the patient’s administrative and clinical data in 

Euroking from the first booking through to postnatal discharge. Each folder on the left-hand side of the screen 

contains one or more questionnaires (Care Pathways) which are opened by clicking the + symbol next to each 

relevant folder. 

 

 

 

 

 

 

 

 

 

 

 

 A blank questionnaire is shown by an icon with no additions. 

 
An icon with a small right arrow indicates that the questionnaire has been opened. It may or may not 

have information in it. 

 Once a questionnaire has been fully completed it will have a green tick beside the questionnaire icon. 

 Clicking the + symbol will expand / open the folder selection, whilst clicking the – symbol will collapse / 

close the folder.  

 

 COMPLETING A TELEPHONE CONTACT - METHODS OF ENTERING DATA 

 
This section illustrates adding a new telephone contact as it is a common task and covers most data entry methods 

in the system. 

 

GENERAL DATA ENTRY PRINCIPALS 

 
Questions can have single or multiple response. Some will request additional information via a text box. Mandatory 

text boxes show the statement “This is mandatory text” under the box. 

 

▪ For a SINGLE ANSWER double-click on the required answer. 

▪ For MULTIPLE ANSWERS and ADDITIONAL INFORMATION REQUESTS, single-click the required answer and either 

click the Save icon, or press the [Page Down] key when all data has been completed. 

 

Either method will save the data entry and automatically moves down to the next question in sequence. 
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- Navigate to the ‘Telephone Contact’ folder and click the [+] symbol. 

 

- Double-click ‘Tel. Contact’ to open the questionnaire. 

 

 
 

- Complete each question and double-click the response to move to the next question, or alternatively press [Page 

Down] on the keyboard. 

 

Date and Time questions all have common functionality  

 

▪ Clicking on the highlighted [-] button between the date and time will display a calendar to select a date. 

 

 

 

 

 

 

 

 
▪ Dates can be typed without entering / forward slashes but must always have the full four digit year - (i.e. 

DDMMYYYYY or 15072019). 

 

▪ It is also possible to enter t = today, t-1 = yesterday (i.e. today minus 1 day). 

 

▪ Times can be entered without the colon (:) symbols between numbers but should be entered using a 24 hour 

clock (i.e. 1500 rather than 15:00). 

 

▪ It is also possible to enter n = time now. 
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- At the ‘Call taken by’ question a list of staff members can be accessed. For example ticking ‘Midwife’ opens a list 

of midwife names from the database: 

 

 

 

 

 

 

 

 

 

 

 

Professional searches all have common functionality: 

 

▪ You can search table using any of the search parameters. 

 

▪ Double-clicking the entry will to add it to the questionnaire. 

 

▪ If the staff member is not listed in the table, click the [Staff Not In List] link which allows the relevant member of 

staff to be entered as free text. 

 

- Complete all questions and click the Save       icon. 

 

- A [Workflow Completed] message will appear, and you will be returned to the Carepath. 

 

COMPLETING THE CARE PATHWAY QUESTIONNAIRES 

 
There are different care pathways according to your user role. The following examples take you through part of the 

midwife ‘Antenatal Care > Booking’ Pathway which normally begins with the ‘Past Medical and Surgical History’ 

workflow questionnaire. 

 
- Open the ‘Antenatal Care’ folder by clicking the [+] symbol. 

 

- Open the ‘Booking’ folder by clicking the [+] symbol. 

 

- Double-click the ‘Past Medical and Surgical History’ care pathway to open the questionnaire. 
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The questionnaire opens and screen changes to display a list of questions on the left-hand side and related the 

associated possible responses on the right-hand side. The current question is highlighted on the left-hand side and 

appears as the heading on the right-hand side of the screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Questions throughout Care Pathway questionnaires are conditional and will often result in the appearance of 

MANDATORY TEXT boxes, or ADDITIONAL QUESTIONS being displayed in context to the response provided. 

 

An example of this is when completing ‘Hypertension’ if the answer is ‘Currently Medicated’ a mandatory text box 

will appear. 

 

 

 

 

 

 

 

 

 

 

 

 

Once text is entered an additional button appears to the right-hand side of the text. Clicking this box will provide a 

continuation page to type up to 500 characters of related detail. Click the [x] icon to close once all text is entered. 
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- Complete all questions and click the Save       icon. 

 

You will also be prompted to complete any other reciprocal questionnaires such as ‘Past Obstetric History’.  

 

If any questions have been missed, a warning will display to advise that the questionnaire will not be marked as 

complete in addition to the number of missed questions. You will also be advised if the [Workflow is incomplete] and 

returned to the appropriate section to complete the details as required. 

 

Questionnaire not completed Number of questions not completed Workflow is incomplete 

   
 
- Once a questionnaire is complete and all questions have the required responses a [Workflow Completed] and a 

green tick will be displayed next to the questionnaire via the Carepath itself. 
 

 
 
 
 

Any partially completed or completed questionnaire can be edited by a user with the appropriate permissions by 
reopening the questionnaire, making any required edits and clicking the save icon. Any changes to questionnaires 
will be recorded via the Topview Audit trail contained in the Tools menu. 
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PRINTING THE BOOKING SUMMARY 

 
When you have completed the antenatal care booking pathway by completing both the ‘Past Medical and Surgical 

History’ and the ‘Current Pregnancy’ questionnaires, you will be offered the option of printing out the ‘Booking 

Summary’ and ‘GP letter’. 

 

 
 

- Select [Yes] to print the document. 

REPRINTING THE BOOKING SUMMARY 

 

OPTION 1 - PRINT EXACT COPY 

 
This option will generate an exact copy of the original report. 
 
- Open the required Patient and relevant questionnaire. 

 

- Click the “Patient” menu at the top left-hand corner of the screen. 

 

- Select [Previously Printed Reports]. This will provide access to all previously printed reports. 

 

 

 

 

 

 

 

 

 

 

 

- Select the report you wish to reprint and click the print icon shown above. It is also possible to click the      green 

arrow icon       to expand the report viewer. 
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OPTION 2 – PRINT A REGENERATED REPORT 

 
- Selecting this option enables you to print an appended copy of the report which includes any subsequent 

revisions to the questionnaire to date. 

 

- Open the required patient and relevant questionnaire. 

 

- Click the “Patient” menu at the top left-hand corner of the screen. 

 

- Select [Regenerate Reports]. This will provide access to all previously printed reports and will update the reports 

with any new information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

- Select the report you wish to reprint and click the print icon shown above. It is also possible to click the      green 

arrow icon       to expand the report viewer. 

 

- To preview the report, click the [Regenerate Report] button. 

 

- To print the report, click the [Regenerate and Print] button. 
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 ANTENATAL CARE – CONTACT FORMS 

 
▪ The Contacts workflows should be completed every time there is an Appointment or Triage Contact made.  

▪ DNA’s should be recorded here as Missed Contacts.  

▪ Additional contact workflows can be added as required by right-clicking on the Contacts folder and selecting the 

required contact 

 
For example – to record a MISSED CONTACT: 

 

- Navigate to the ‘Contacts’ folder in the ‘Antenatal Care’ pathway. 

 

- Click the ‘Contacts’ [+] symbol. 

 

 

 

 

 

- If there is no empty ‘Missed Contact’ form available, right-click on the Contacts folder and select [Add Missed 

Contact]. 

 

- Double-click the ‘Missed Contact’ item you have just created. 

 

 

 

 

 

 

 

 

 

- Complete all questions and click the Save       icon. 

 

- A [Workflow Completed] message will appear, and you will be returned to the Carepath. 
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9. Care Pathways – Delivery Care 
The ‘Delivery Care’ pathway is designed to record all the relevant details pertaining to labour and delivery. In the 

event of a registerable birth EuroKing will create a submission to the PDS (Personal Demographics Service) to obtain 

an NHS number for the baby. A baby record will then automatically be created in EuroKing which is then completed 

with details of the baby examination, postnatal transfer and finally discharge from care. 

 

METHODS OF BABY REGISTRATION 

 
In the UK baby registration is undertaken via the national, electronic database of NHS Patient Demographic Service 

(PDS Registration) which can be integrated to Euroking, in addition to a separate integration with the local PAS 

System (PAS Registration). 

 

Automatic PDS and PAS Registration 

(Recommended Approach) 

Euroking would recommend that customers deploy both integrated PDS 

REGISTRATION and PAS REGISTRATION as when implemented EuroKing 

first validates the submission and then sends the form to PDS, which 

registers the baby and issues an NHS number for the baby back to 

EuroKing. Following this Euroking submits all demographics including the 

NHS number to the local PAS, and receives a reciprocal PAS update 

containing the baby’s PAS registration / Hospital number which is then 

amalgamated into the overall Euroking baby record. 

 

Please note: Euroking also includes Statistical Reports and Alerts for any record which do not have an NHS or Hospital number to enable System 
Administrators and End Users to take any appropriate remedial action via PAS or Euroking. 

 

There are, however, alternatives methods adopted within our customer base, including customers who do not 

subscribe to PDS registration (i.e. Republic of Ireland) as follows: 

 

Baby Range Registration 

(Not Recommend) 

EuroKing can support the use of a pre-defined “Baby Range” which is a 

block of numbers that have been ringfenced for use by relevant clinical 

systems via PAS. If EuroKing uses this system, a demographic update will 

be sent back to PAS to update the allocated Hospital number with the 

specific details for the baby. This method does however requires additional 

checks to ensure due diligence and the integrity / accuracy of data 

between the local PAS System and Euroking. 

 

Manual Baby Registration 

(Not Recommend) 

Some customers choose not to implement either an Automatic PAS 

Registration or Baby Range Registration. In this scenario they may or may 

not subscribe to the PDS Registration service.  If there is no interface to 

PAS from Euroking babies can still be registered, but it is then the sole 

responsibility of customer to ensure babies are reciprocally entered via the 

local PAS and the Euroking baby record is subsequently updated with the 

relevant Hospital number (and NHS number, if applicable). 



 

© Wellbeing Software 2019                          All Rights Reserved  Commercial in Confidence 
Effective Date – ESM 16/12/2019   
Wellbeing Doc ref:  EK_CRIB_CM_700_EuroKing_MIS_End_User_Documentation_WS_V1.1.docx   Page 25 of 41 

  

DELIVERY CARE – PRE-DELIVERY, LABOUR, DELIVERY AND SUBSEQUENT BABY QUESTIONNAIRES 

 
- Open the ‘Delivery Care’ folder either by clicking the [+] symbol. 

 

- Navigate to the ‘Pre Delivery’ questionnaire by double-clicking it. 

 

 

 

 

 

- Complete all questions and click the Save      icon. 

 

- A [Workflow Completed] message will appear, and you will be returned to the Carepath. At the point of 

completion of the Pre Delivery questionnaire EuroKing creates a folder labelled ‘Baby 1’ which contains two 

questionnaires – ‘Birth’ and ‘Instrumental Delivery’. A folder would be created for each baby in a multiple birth. 

 

- Open ‘Labour and Delivery’ by double-clicking, and complete the questionnaire.  

 

Upon completion of the Birth questionnaire(s) EuroKing will generate a validation form for a PDS Submission (if 

applicable). For successful baby registration, all items must be completed. Any incomplete items are displayed in red 

with an X against them and PDS validation fails. All failed validation items would need to be completed accurately to 

allow the submission to PDS to go ahead. 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

If all items are completed as required, the validation will be passed and submitted as follows: 
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It should be noted that if validation fails, it is still possible to click [Cancel] to register the baby but the NHS number 

will need to be subsequently updated manually. 

 

If PDS Registration is NOT in use (i.e. Republic of Ireland) the Baby Registration form will display automatically.  

 

BABY REGISTRATION FORM 

 

The ‘Baby Registration’ form is now displayed and should be completed to enable the baby to be registered on the 

hospital PAS. Most details are pre-populated from previous entries, but it will be necessary to update the baby’s 

ethnic origin. 

 

 

 

 

 

 

 

 

 

 

 

 
 

 
 
Once completed the record will be updated and a [Workflow Completed] message will appear. A ‘Baby Message’ will 
then be sent to PAS (if local PAS baby registration is in use). It should also be noted that in the event PDS registration 
fails, the PAS message will still be sent but without an NHS number. 
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10. The Neonatal Record 
Once baby registration is completed via the ‘Labour and Delivery’ questionnaire, EuroKing creates a neonatal record 

for the baby which can be accessed from the mother’s record via the baby icon: 

 
 

 
The neonatal record is selected by highlighting and double-clicking the record to load the details. 

 

 
 
The format of the neonatal record is very similar to the maternal record. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FORMS IN THE BABY/ NEONATAL RECORD 

 
The following icons enable access to relevant forms within the neonatal record.  

 

 

If the baby has been born to a woman whose pregnancy record is held within the EuroKing system, certain details 

will be pre-populated from the Mother’s file, whilst other details will need to be manually completed. 

 

Icon Description Purpose 

 Demographics 

Baby details, contact details, and address. It should be noted that in most instances 

this information is directly populated from both the maternal record in Euroking 

and the PAS (Patient Information Systems) or HIS (Hospital Information System) 

 General Details Details such as blood group, religion, gender and ethnic origin. 
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 Parent Details Mothers name, address and NHS number derived from the maternal record. 

 Birth Summary 
Details of the birth such as birth order, birth weight, delivery mode and Agpar 

Scores. 

 
Resuscitation 

Details 

Details of any resuscitation procedures at birth such as type, drugs given, intubation 

details. 

 Care Professionals 

This identifies the individuals involved in the baby’s care. This form can be manually 

completed but it is also loaded from pathway questionnaires. The GP Details are 

completed automatically with information derived from the PAS (Patient 

Information Systems) or HIS (Hospital Information System). 

 
Baby/Neonatal 

notes 

This will display any existing baby / neonatal notes and allows the addition of new 

notes. 

 Mother Record Links back to the reciprocal maternal record. 

 Add Alerts 

Users are given a choice of alerts from a drop-down menu and to record details. 

Includes a link from the Mothers record so that risks identified during pregnancy 

can be continued into the baby record. 

 Add Risks 
Users are given a choice of risks to add to the record from a drop-down menu and 

to record details. 

 Save Any entries or changes made to any forms should be saved before closing. 

 

BABY/NEONATAL CARE PATHWAYS 

 
‘Baby’ Care Pathways are divided into ’Normal Care’ and ‘Contacts’: 
 
 

 
 
 
 
 
 
 
 
 

NORMAL CARE PATHWAY 

 
The ’Normal’ Care Pathway contains the following questionnaires: 
 
Examination     Records details pertaining to the examination of the baby at birth. 

 

Neonatal Transfer to Community  Completed when the baby is transferred from the hospital, Midwife Led 

Unit (MLU) or Delivery Suite to the community. Re-admissions are also 

managed within the same questionnaire. 
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Final Discharge from Care The record of the final discharge with a simple synopsis of the neonatal care 

provided. 

 

CONTACTS CARE PATHWAY 

 
The ‘Contacts’ Care Pathway provides a record of contact with the baby in the community, or hospital. This section 
should also be used to record any missed contact by the family. 
 

BABY BORN ELSEWHERE 

 
If the baby has been born outside of the current hospital, the baby record would need to be created the PAS (Patient 

Information Systems) or HIS (Hospital Information System) for demographic details to be transferred to EuroKing. 

However, all delivery information and neonatal care will need to be added manually.  

 

- To do this you would need to right-click on the ‘Normal Care’ folder and select [Add Baby Born Elsewhere]. 

 

 
- The questionnaire will load in the ‘Normal Care’ pathway ready to be completed. 

 

 
- You should complete and save all required questions in each relevant questionnaire. 

 

- A [Workflow Completed] message will appear, and you will be returned to the Carepath. 
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11. Euroking Messages 
The Euroking message function is designed to enable communication between professionals from within the 

application. It has not been designed to function in the same mode as an email. It is a simple messaging system which 

will allow information to be shared between professionals when they log into the Euroking system. 

 

The function is accessed via the Main Menu / Start Page. 

 

 

READING A MESSAGE 

 

The number of Unread Messages is displayed next to the [Read my messages] hyperlink.  

 

- To read the message click on the [Read my messages] link which will load the messages Inbox. 
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▪ Messages marked as “Important” are displayed in bold with a red exclamation mark. 

▪ The selected message also has a right arrow icon. 

 

- Highlight the required message and double-click to open. 

 

 

 

 

 

 

 

 
 

 

- To close the message, click the [x] icon. 

 

- The message can be left in the user inbox or deleted by clicking the [Delete Message] button as applicable: 

 

 

 

 

 

 

 

SENDING A MESSAGE 

 

- To send a message click on the [Send New Message] button. 

 

 

 

 

 

 

 

Messages can be sent to:  

 

▪ [All Users]   - All System Users 

▪ [User Role]   - One or more User Role(s) 

▪ [Individual User]  - One or more Individual User Accounts 
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- In each case you should click the required recipient type for the message followed by the specific User Role(s) or 

Individual User(s) where applicable. 

 

 

 
 

  
 

- To assign User role(s) or Individual User(s) click to highlight the required recipient and either click the right arrow 

button to add [ > ] as many times as required or the left arrow button [ < ] to remove if applicable. 

 

- You can also mark messages as “Important”, if required before clicking the [Send] button. 

 

- A [Message send successfully] pop up will appear, which you should acknowledge by clicking [OK] before 

closing the message itself using the [X] icon at the top right-hand corner of the box. 

 



 

© Wellbeing Software 2019                          All Rights Reserved  Commercial in Confidence 
Effective Date – ESM 16/12/2019   
Wellbeing Doc ref:  EK_CRIB_CM_700_EuroKing_MIS_End_User_Documentation_WS_V1.1.docx   Page 33 of 41 

  

Document Control 
Title Euroking Maternity Information System (MIS) - End User Support Documentation 

Owner Wellbeing Training Manager Date Created 19/05/2019 

File Ref. EK_CRIB_CM_700_EuroKing_MIS_End_User_Documentation_WS_V1.1.docx 

CRIS Version  

Change History 

Issue Date Author / Editor Details of Change 

D1.0 19/05/2019 Elaine Scotter First Draft Issue  

D1.1 28/06/2019 Elaine Scotter 
Edits to Management report information, addition of Baby/Neonatal 

record information. 

D1.2 21/07/2019 Emma Savage-Mady 
Review and revisions including template updates, graphic updates and 
general formatting in line with documentation formatting 
standardisation. 

V1.0 01/08/2019 Emma Savage-Mady First Release 

D2.0 06/11/2019 Emma Brown Commented on Login, Father Details, and Care Pathways. Grammar. 

V1.1 16/12/2019 Emma Savage-Mady Edits and reissue. 

    

    

Review Date 16/12/2021 

 


